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Overview 
This What’s New document is intended for those of you who are already familiar with VCarve Pro 
and just want to check out the new stuff, which is highlighted here. To aid this process, the changes 
associated with version 6.5 and version 6 have been separated into the two major sections of this 
document. If you are upgrading from version 6, the second section of this document should already 
be familiar to you and you may wish to focus only on the very newest stuff in section one. However, 
if you are upgrading from VCarve Pro 5.5 or earlier you will benefit greatly from both sections of this 
document. 

This document is structured as follows: 

• New for VCarve Pro 6.5 
o New Features 
o Enhancements 

• New for VCarve Pro 6 
o New Features 
o Enhancements 

If you are completely new to VCarve Pro, this probably isn’t the right document for you. Instead you 
should refer to the VCarve Pro User Guide and VCarve Pro Reference Manual for a full overview of 
VCarve Pro’s capabilities and a comprehensive explanation of each tool and feature of the software.  
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New for VCarve Pro 6.5 
Integrated Windows Explorer Thumbnail SupportFrom VCarve Pro 6.5 onwards, CRV files 
automatically include thumbnails when they are saved. Windows Explorer can make use of these 
thumbnails to show you a preview of each file when you browse a folder. 

When browsing a folder of CRV files in Windows 7, select Medium Icons or larger from the available 
options in the Change your view control, located at the top of the Windows Explorer view. 

  
Thumbnails are supported for Windows XP and later, but the method of selecting thumbnail view in 
Windows Explorer described above is specifically for Windows 7 and will differ slightly for other 
Windows versions. 

Drag & Drop 
If no file is currently open, VCarve Pro supports Windows drag and drop functionality to open a file 
directly from Windows Explorer. Simply click and drag the thumbnail of the file you wish to open 
from the Explorer Window into VCarve Pro’s window. 

Note: You will only see thumbnails for CRV files saved from VCarve Pro version 6.5 or later. If you 
are only able to see the default VCarve Pro file thumbnail, you should open and re-save the file 
using the normal File>Open and File>Save commands in the latest version of VCarve Pro. 
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Create Arc 
The Create Arc tool allows a single arc 
span to be created using precise values, 
or dynamically within the 2D View. 

Left click the mouse in the 2D View to set the start 
point of an arc. Click again to set the end point 
position.  

Move the mouse and click a third point to set the 
arc’s radius or, alternatively, select Radius, Height 
or Mid Point on the Create Arc form and enter the 
precise value you need. 

Notes 
• Clicking the Right mouse button or 

pressing the Esc key finishes the 
operation 

• The properties of an arc can be 
edited at any time by selecting the 
arc before choosing the Create Arc 
tool. This opens the form with the 
current properties and position of 
the selected arc and these values 

can then be edited. Click Apply  to update the selected arc with the new values. 
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Printing & Print Preview 
The contents of either the 2D or 3D view can be printed using the Print command on the File menu. 
Simply select the view you wish to print (2D or 3D) and then click the Print command. The standard 

Windows printer dialog allows you to select the printer and adjust its properties. When the OK  

button in this dialog is clicked, the view will be printed. To adjust the printer settings without 
printing, you can open the same dialog using the Print Setup… command on the File menu. When 

used in this way, the OK  button on the dialog will store the settings without printing immediately. 

By default printing the 3D view does not print the shaded background; this behavior can be 
changed using the options dialog, which is opened using the Options command on the Edit menu. 

The Print Preview command on the File menu allows you to check the layout of your page before 

you print. If you are happy with the preview, use the Print…  button to begin printing the document 

directly from the Print Preview page. 

The printed view is always scaled to exactly fit the currently selected page size (including allowance 
for margins). Drawings are not, therefore, printed at actual size and are not printed across multiple 
pages. 
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New Options for Existing Tools for VCarve 
Pro 6.5 

As well as completely new features, this version of VCarve Pro includes a number of enhancements 
and new options to the existing features of VCarve Pro 6. 

Pass Depth Control for Profiling 
When a profile toolpath is created, the Pass Depth 
value associated with the selected tool (part of the 
tool’s description in the Tool Database) is used to 
determine the number of passes needed to profile 
down to the specified Cut Depth. However, by 
default VCarve Pro will also modify the tool step 
down by up to 15%, if by doing so it is able to reduce the total number of passes required to reach 
the desired cut depth. It is usually desirable to benefit from the significantly reduced machining time 
of cutting profiles using less passes if possible. Nevertheless, there are some occasions where the 
exact step down for a given profile pass needs to be more precisely controlled - when cutting into 
laminated material, for example. The Passes section of the 2D Profile Toolpath page indicates how 

many passes will be created with the current settings. The Edit Passes…  button will open a new 

dialog that enables the specific number and height of passes to be set directly. 

Specify Pass Depths 
The Pass Depths section at the top of the form 
shows a list of the current pass depths. The 
relative spacing of the passes is indicated in the 
diagram next to the list. Left click on a depth value 
in the list, or a depth line on the diagram, to 
select it. The currently selected pass is highlighted 
in red on the diagram. 

To edit the depth of the selected pass, change the 

value in the Depth edit box and click Apply . 

The Delete  button will delete the selected pass. 

The Clear All Passes  button will delete all the 

passes. 

To add a new pass, double left click at the 
approximate location in the passes diagram that 
you wish to add the pass. A new pass will be 
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added and automatically selected. Edit the precise Depth value if required and then click Apply . 

The Set Last Pass Thickness option will enable an edit box where you can specify the last pass in 
terms of the remaining thickness of material you wish to cut with the last pass (instead of in terms of 
its depth). This is often a more intuitive way to specify this value.  

Pass Depth List Utilities 
This section of the form includes two methods for creating a set of passes in one go.  

The first method simply sets the passes according to the Pass Depth property of the selected tool. By 
default, this is the method used by VCarve Pro when it creates profile passes initially. However, the 
Maintain exact tool pass depth option checked, VCarve Pro will not vary the step size to try and 
optimize the number of passes (see above). 

The second method creates evenly spaced passes according to the value entered in the Number Of 
Passes edit box. 

To apply either method click the associated Set Passes button to create the resulting set of pass 

depths in the passes list and diagram. 

Note: Setting the number of passes with either of these utilities will discard any custom passes you 
may have added. 
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Miscellaneous Improvements in VCarve Pro 
6.5 

Improved Font Previews 
When browsing the installed fonts in the Create Text tool, VCarve Pro shows a small preview sample 
of text using each font. The set of characters in the preview now includes some numbers, which can 
often be valuable in aiding font selection for some projects. 

Extensions to the embedded Calculator 
The number edit boxes on most VCarve Pro forms and dialogs can also interpret simple sums and 
equations. In VCarve Pro 6.5 there are now two new constants, M and I, which you can use in 
number edit boxes to simplify conversion to millimeters and inches, respectively. 

Example: Thus entering 1.0*M= into a number edit box will result in 25.4, the number of 
millimeters in one inch.  

Faster start-up time 
VCarve Pro 6.5 takes advantage of multi-threaded processing to significantly reduce the time it to 
start VCarve Pro and start working. 

Saving PNG images of your 3D View 
It is often useful for advertising or customer approval to be able to capture an image of your 3D 
simulation. When using View>Save Shaded Image, a new file type option has been added in VCarve 
Pro 6.5 enabling you to save PNG files. The PNG has the unique benefit of supporting background 
transparency so that your image can be cut and pasted into other images or documents without 
including the 3D View background. To enable this feature, simply switch off the gradient background 
setting in the 3D View Options – subsequently saved PNG images will have transparent backgrounds. 
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New for VCarve Pro 6 
This chapter describes the new tools in VCarve Pro 6 

• The Interactive Distortion Tool allows you to bend or flex a vector or component using 
VCarve Pro’s node editing tools to manipulate a distortion envelope surrounding the target 
object. 

• Toolpath Tiling allows you to overcome any limitations of your machine’s bed, or available 
material block size so that you can still cut large projects. 
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Distort Tool 
This tool allows you to bend and flex a vector by manipulating a distortion envelope using 
VCarve Pro’s standard node editing tools. You can select one or more vectors or 
components and then use one of the three different tool modes to create your initial  

Once the distortion envelope has been created, you 
can use VCarve Pro’s node editing tools to add or edit 
its nodes and spans. As you alter the shape of the 
envelope the associated object will be distorted to 
reflect the changes.  

Distorting a Previously Distorted Vector 
Once a vector has been distorted, node editing will 
always relate to the object’s distortion envelope. If you 
wish to edit a distorted vector directly again, you will 
first need to permanently apply the distortion to the 
shape. To do this, use the Convert to Curves command. 

Bounding Box 
This option is available if you have a selection of 
vectors. It creates a distortion envelope based on the 
closest bounding box that can be drawn around your 
selection. Thus the resulting envelope is always initially 
a rectangle, comprising four line spans and a node at 
each corner. Using the normal node editing tools, 
however, you can modify this envelope as much as you like and the shape within it will be distorted 
accordingly. 

Along A Curve 
This option is only available if the last item in your selection is an open vector that VCarve Pro can 
use to define a curve along which the other selected objects will be distorted.  

Using this option, you will usually end up with your objects bent to match the curve in your original 
selection. The distortion curve itself is left unchanged by this operation. 

Between Curves 
This option will become available if the last two objects in the current selection are open vectors, 
between which the other objects can be distorted.  
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The selected objects will be stretched and squeezed between the two curves that were last in the 
selection. Neither of the contributing distortion curves in the selection will be altered by the 
operation. 
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Toolpath Tiling 
Using the Toolpath Tiling options it is possible to machine objects and designs that are 
many times larger than the available area of your CNC machine bed. This process is also 
invaluable if the maximum sizes of your material pieces are limited. In both case, a much 

larger project can still be achieved by breaking the toolpath down into manageable tiles or strips, 
each of which can fit within the machineable area of your CNC machine, or on the available material 
blocks. Once cut, the tiles can then be re-assembled to form the finished piece. 

The process of tiling begins by creating toolpaths based on the final object entirely as normal – at 
this stage you do not need to take any account of the available machining bed size. Once you have 
calculated required toolpaths, click on the toolpath tiling button in the toolpaths pane to open up 
the toolpath tiling form. 

The Toolpath Tiling Manager 
The toolpath tiling form will ‘split’ the full-size toolpaths into a number of discrete, but precisely 
aligned, toolpath tiles as soon as you click the Update Tiles button. While the Tile Toolpaths mode is 
enabled (using the checkbox on this form) any toolpaths that you save will automatically divided into 
tiles. 

The top section of tiling form 
allows you to set the type of tiling 
you require (see below for more 
information) and the appropriate 
settings for each tiling strategy.  

The lower section of the tiling 
form allows you to select and 
activate each of the tiles. The 
currently active tile can be 
previewed in either the 2D or 3D 
View.  

Tiling Options 
There are three layout strategies 
for tiled toolpaths, the most 
appropriate one will depend on 
your machines capabilities and 
the available material. 

Individual Tiles 
The first tiling option is for 
individual tiles. This splits the 
current job in both X and Y, to 
form a series of entirely separate 
toolpaths. This is generally the 
preferred option if you have 
independent pieces of material to 
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machine, or if you have a moving-bed type CNC machine that will not allow you to ‘overhang’ 
material outside of the machineable area. 

With this option selected, you are asked to specify the width and height of each tile, and the 
required overlap (which will be applied in each direction). Tiles are created from the bottom left of 
your model. The overlap for independent tiles is particularly important for 2.5D toolpaths that utilize 
the shape of your tool bit (such as V-bit carving). 2.5D toolpaths will need to ‘overrun’ the edges of 
your tile in order to complete their cuts using the side of the bit. For this reason, the overlap 
distance for Independent Tiles will typically need to be at least equal to the radius of your tool bit. 

Feed-through in X or Feed-through in Y 
Instead of cutting a series of individual pieces of material and assembling them later, it can also be 
convenient to cut a single strip of material using a series of set-ups – moving the material through 
the machineable area between cuts. VCarve Pro specifically supports this technique using the Feed-
through in X/Y options. In these cases you will only need to define either the Tile Width or Height 
(which corresponds to your intended feed-through distance), as the other dimension is assumed to 
correspond to the shorter side length of your material and will match the equivalent current job 
dimension. Similarly, the overlap distance is only applied in the direction of the draw-through. 
Because you will typically be cutting the same piece of material with each toolpath tile, the overlap 
distance for Feed-through is not as critical as for Individual tiles and is typically used to allow for a 
margin of error in your set-up accuracy. 

Once you have set your tiling option, click the Update Tiles button to see your settings reflected in 
the Tile Previews in either the 2D or 3D Views. 

Tile Previews 
The 2D View indicates how the model area is split into tiles. The yellow lines indicate the tile sizes, 
but the light red areas also indicate the overlap region for each tile. You should pay particular 
attention to the fact that this overlap can take the toolpath outside of the tile boundary – this is 
necessary to ensure that 2.5D toolpaths, in particular, form the correct shapes at the tile edges. 
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An independent toolpath tile preview in the 
2D View. The light red areas indicate the 
current overlap settings for this tile. 

This image shows the same toolpath tile’s 3D 
preview, positioned relative to the machining 
origin. You should note that the tool will machine 
negative, as well as positive, relative to its origin in 
this case. You must allow for this necessary effect 
when setting up your material and origin for 
machining. 

 

When you come to machine these tiles you should take care to allow for the overlap distance when 
setting your machining origin on your material. Internal tile toolpaths can machine negative, as well 
as positive, relative their origin. 

The currently active tile can be set directly from the 2D View by double-clicking on the background 
of one of the indicated tile regions. 

Simulating Tiled toolpaths 
You can also view and simulate individual toolpath tiles in the 3D View. To view the toolpath tiles, 
simple ensure that the toolpaths are visible (checked in the Toolpath List) and then select the tile 
you wish to see either from the Tile Toolpaths from, or the 2D View (see above). 

Since tiles are created so that they will all be cut within the same machineable area (i.e. they are all 
located in a similar position relative to the machining origin), this can make them difficult to visualize 
using Preview Toolpaths. Simulating each toolpath tile in its absolute position will result in the 
toolpaths being cut in the same region of your preview block and they will overcut the same area. 
The Tile Toolpaths form has an option Draw toolpaths in original position for visualization to allow 
you to simulate the tiles as if they were arranged in their final pattern. With this option enabled, you 
can visualize how your final piece will look by previewing all your toolpath tiles together, but you 
should note that it will not reflect the true offset of each toolpath 
from your machining origin. 

Saving toolpath tiles 
Provided you have created toolpath tiles using the Tile Toolpaths 
form, an additional option, Output Tiled Toolpaths, will be available 
in the toolpath saving form. 
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It will be checked or unchecked to match the current state of the Tile Toolpaths check box in the Tile 
Toolpaths form.  

Note: If the Output Tile Toolpaths option is grayed-out this means that no tiles have been created. 
You will need to close the Save Toolpaths form and use the Tile Toolpaths form to create the 
toolpath tiles before continuing. 
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New Options in Existing Tools for VCarve 
Pro 6 
A number of tools have been enhanced or updated in VCarve Pro 6 to add new functionality or to 
improve the workflow when using them. 

• Layer management has also been improved with additional control over layer ordering, and 
the ability to automatically activate new layers as and when they are created. 

• Tool Templates are a powerful new way of applying commonly used toolpath settings and 
strategies to your project, rapidly and efficiently. 

• The Tool Database can now be organized into groups of similar tooling, and notes can be 
added to your tool definitions.  

• Additional Preview Control tools have been added. These give you precise control over the 
toolpath simulation process. In addition you can now single-out a sub-set of your calculated 
toolpaths and easily simulate them in isolation. 

• Where appropriate, the numerical edit fields on VCarve Pro’s tool forms can now perform 
simple calculations in-situ, saving you time and helping to reduce errors. 
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Layer Management 
A number of improvements have been made to the way that 
VCarve Pro helps you to manage your 2D drawing layers. A 
simple but very useful addition is the New Layer is Active 
option on the Add New Layer dialog. With this option 
checked, newly created layers will become active and 
subsequent actions will automatically use it. 

Layer Ordering 
While the visibility of vectors is largely unaffected by the order in which they are drawn, Bitmap & 
2D Component Previews can easily obscure one another if drawn in the wrong order (see 
Component Preview Drawing Order for a longer discussion on this issue). Layer order can be changed 
from layer management dialog using the up and down arrow icons below the layer list control.  

New Copy to Layer pop-up command 
When you right-click an object in the 2D view an additional option to copy (rather than move) to a 
new or existing layer is now available. 

Ungroup to the group’s layer 
By default, when grouped objects are ungrouped they revert to the layers on which they had 
previously been located before the grouping operation. However this is sometimes inconvenient. For 
example, when you have copied a group of vectors to a new layer, it is easier for subsequent editing 
if the copied vectors to remain on the new layer, even after ungrouping. An alternative right-click 
pop-up menu command has been added to make this process easier.  

A new shortcut key combination has also been added to provide support for both of the ungroup 
operations. 

Shortcut Action 
G Group the selected objects 
U Ungroup the selected objects to their original layers, sub-groups remain grouped. 
Ctrl + U Ungroup the selected objects to the group’s layer, sub-groups remain grouped. 
Shift + U ‘Deep’ ungroup the selected objects to their original layers. Sub-groups are also 

ungrouped. 
Ctrl + Shift + U ‘Deep’ ungroup the selected objects to the group’s layer. Sub-groups are also 

ungrouped. 

Quick select all vectors on a layer 
The layer manager now allows you to quickly select all of the vectors (automatically excluding other 
objects, such as component previews) on a particular layer. Simply double-click the layer name in 
the layer list of the Layer Manager. VCarve Pro will activate the clicked layer, and select all the 
vectors on it. 
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Toolpath Templates 
Toolpath templates allow you to improve the efficiency of your production processes by 
saving the complete toolpath settings for common operations. These settings can then be 
re-used at any time on different design geometry. Frequently used strategies and tooling 

can thus be applied to similar jobs, quickly and easily. 

Simple Toolpath Templates 
Using the Toolpaths → Templates Save Selected Toolpath as Template menu command (or the 
associated icon), all the settings for the currently selected toolpath can be saved as a template. 
When you reload this file (using Toolpaths → Templates → Load Template...) you will have an 
empty toolpath which can be edited by double clicking on its name in the toolpath list or selecting 
the Edit Toolpath icon in the Toolpaths tab. Once the toolpath form is open, the vectors to be 
machined can be selected and the toolpath calculated using all the saved settings.  

The Toolpaths → Templates → Save All Visible Toolpaths as Template menu command (or the 
associated icon) allows a group of toolpaths to be saved as a single template. As an example, the 
toolpaths may have all the settings used for Profiling and Pocketing operations for a particular type 
of job and material combination. These toolpaths settings can then be recalled simply by opening 
the template and selecting the appropriate vectors for each toolpath. 
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Vector Selection 
To help with selecting the vectors used for a particular toolpath, 
the Vector Selector tool has been added. The dialog for this tool 
allows you to easily select vectors which meet a set of criteria, 
such as open, closed, circular and also matching constraints 
based on layers. The dialog can be accessed from the Edit 

→Vector Selector menu item, or from the Selector…  button 

on each toolpath form. When the command is executed the 
dialog shown on the left is displayed. 

The dialog is used to configure a set of ‘filters’ that determine 
which vectors will be selected. As a filter is enabled by clicking 
on its check box, or selecting a different ‘radio button’ option, 
the current selection will be updated with all the objects in the 
file which match the current filter options. 

Generally you will start at the top of the dialog and work 
downwards, specifying more and more explicit filters to 
determine the required selection exactly. 

The simplest option is just to use the form to Select Closed 
Vectors in the job or Select Open vectors (you can specify both, 
in which case all vectors will be selected as long as they are on a 
visible layer). 

The most common way to use the Vector Selector is to select all the vectors on a given layer as 
shown in the screenshot of the dialog below. 

In this example, the dialog has been used to select All Closed Vectors on the layer with the name 
Pocket. 

The Selection: section at the top of the dialog is continuously updated to show the results of the 
current filter and the 2D view is also updated to show what is currently selected. The Objects: entry 
shows the total number of objects selected, if these objects include Text or Groups, this number may 
be less than the total of Closed and Open vectors displayed on the following line. For instance, a 
block of text is one object but will usually consist of many closed vectors. If a group contains both 
open and closed vectors, it will be selected as matching both Open and Closed filters. 

The Geometry Filters section is used to specify constraints on the type of vectors to select. You can 
choose to select open vectors and/or closed vectors. Instead of selecting All Closed Vectors, the 
dialog can be used to select Only Circles and can even be used to specify an exact diameter and 
tolerance for the circles to be selected. This can be very useful for selecting vectors for drilling 
toolpaths, particularly if the vectors have not already been sorted into layers. 

The Layer Filter section allows you to pick one or more visible layers on which to select vectors 
which match the geometry filter. Alternatively, the All visible layers option disables the filtering by 
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layer and selects all vectors which match the geometry filter regardless of the layer they are on, as 
long as that layer is visible.  

The Associate with toolpath option will be explained in the next section. 

Advanced Toolpath Templates 
By associating a template with the result of a Vector Selection filter, we can make a template 
automatically select the vectors it is intended to machine. A simple case would be to create a 
template which consisted of a Pocketing toolpath set up to machine all closed vectors on a layer 
called Pocket. After loading this template into a new job and choosing Toolpaths → Recalculate All 
Toolpaths the toolpath would be recalculated, automatically selecting all closed vectors on the layer 
called Pocket.  

The advanced templates are created by selecting the vectors for a toolpath using the Selector…  

button on the toolpath form. When a toolpath form is first opened, the Vector Selection: section on 
the form will show that vectors are being selected manually as shown below... 

 

Pressing the Selector...  button will display the Vector Selector form as shown previously. After 

making your geometry selection and before you close the form, select the Associate with toolpath 
option on the form as shown below.  

 

 

After the Vector Selector form closes, the Toolpath form will indicate that Vector Selection is now 
‘Automatic’ as shown below... 
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IMPORTANT:  Calculate the toolpath to apply the changes you have made.  

When you re-calculate or edit a toolpath that has the Vector Selection mode set to automatic, the 
vectors which match the filter when the toolpath is re-calculated or edited will be selected. To 
cancel the Automatic vector selection mode, you can just select  the vectors to machine normally 

with the mouse, or use the Selector...  button to bring up the Vector Selector dialog again (the 

settings are remembered) and uncheck the Associate with toolpath option. 

If toolpaths with the Vector Selection mode set to Automatic are saved as templates, these setting 
are saved with the template. When the template is re-
opened and the toolpaths recalculated, they will 
automatically select all vectors which match the filters 
specified with the Vector Selector for that toolpath. 

If you load a toolpath template which has toolpaths 
associated with layers which don’t exist in the current file, 
the Missing Layers for Template dialog will be displayed. It 
lists all the missing layers and offers you the choice of having 
them created automatically, deleting toolpaths associated 
with missing layers or just loading the toolpaths as is.  

Choosing to allow the dialog to automatically create the 
missing layers allows a toolpath template to be used to create ‘standard’ layers for machining 
operations and load the toolpaths ready to be calculated. All you then need to do is move vectors to 
the appropriate layers and recalculate all the toolpaths. 

Choosing the Delete all toolpaths associated with missing layers option allows you to create a single 
template with many toolpaths and have the ones which aren’t appropriate to the current job 
automatically deleted. 
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Tool Database 
The tool database has seen a significant overhaul in VCarve Pro 6. The most immediately 
obvious change is that you can now group tools in any way you like. 

As with many lists in VCarve Pro, you can reorder your tool database by simply dragging and 
dropping the tools in the locations that you want 
them.  

Creating a new tool group 
Click on the add New Group  button then give 

your new group a name and press Apply  to add it 

to the database. Click and drag tools from the 
database over the top of the newly created group 
icon in the tool database tree to add them to the 
group. Alternatively, select the group and then 

click the New…  button to create a new tool 

directly within the selected group. 

Tool Notes 
The tool notes section simply allows you to save any additional text descriptions, special instructions 
or relevant information you may require, within your tool definition.  

Tooltip of group hierarchy 
When a tool is selected within a toolpath strategy page, the tool name 
does not always provide enough information for you to know whether 
the tool’s settings are appropriate. This will become particularly 
significant if you import a toolpath template (see Toolpath Templates) 
with a tool that has been pre-defined (perhaps by a 3rd party) when 
the template was created. It is always possible to click Edit and see the 
full set of the tool’s properties & settings. However, if you hover your 
mouse over the tool’s name, VCarve Pro will now also provide a tooltip 
telling you what the tool group hierarchy was for this tool when it was 
added to the toolpath strategy or template. This can be extremely 
useful for quickly distinguishing between tools in your database that 
have similar names, but have been grouped according to their 
properties. 

Importing and Exporting tool definitions 
Individual tools or complete tool group hierarchies can now be saved to disk using the Export…  

button. Similarly, you can now import previously saved tools, groups or even entire tool databases 

using the Import…  button. 

Note: VCarve Pro 6 will import database files from VCarve Pro 5, so you can easily add any 
previously defined tools to your new database. Please note, however, that you will not be able to 
open VCarve Pro 6 database files in earlier versions of VCarve Pro. 
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Toolpath Previews & Simulation 
The toolpath preview form has a number of additional commands to help with controlling the 
toolpath previewing process. 

Preview Control Simulation 
The preview controls provide full video-like playback control of your toolpath. You can use this mode 
to analyze the tool moves in detail, step-by-step. To begin using Preview Control, click on the Run 
button. 

The Preview Control buttons are summarized below: 

      

Run Pause Single Step Run to Retract Stop 

Begins Preview 
Control 
simulation 

Temporarily halts 
the tool in its 
current position 
and enables the 
Stop button so 
you can exit 
Preview Control 
mode 

Moves the 
toolpath on by 
one tool move. 

Runs the toolpath 
to the next 
retract move, 
then pauses the 
tool. 

Exits Preview 
Control mode. 

 

Note: To cancel the process of previewing a toolpath using Preview Control, first click the Pause 
and then the Stop buttons.  
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Preview Visible Toolpaths 
The Preview Visible Toolpaths command on the Toolpath Preview form allows you to single-out a 
subset of toolpaths to be simulated, quickly and easily. Simply isolate the toolpaths you wish to 
preview by un-ticking the visibility checkboxes of the other toolpaths in the list. The 3D View should 
now only be displaying the toolpath previews of the toolpaths you are interested in. Click the 

Preview Visible Toolpaths  button to begin the simulation.  



 
Copyright © 2011 Vectric Ltd. All Rights Reserved. Page | 25 

 

Calculation Edit Boxes 
Where appropriate, numerical edit boxes on all of VCarve Pro’s forms support simple calculations. 
Instead of working out a value from a calculation, a sum can be entered directly into the edit box.  

When the ‘=’ character is entered, VCarve Pro will perform the 
entered calculation and fill the edit box with the answer. 

Special Calculation Characters 
As well as the simple numerical calculations, VCarve Pro also supports several special characters to 
simplify common measurements. These characters are not case-sensitive. When used, VCarve Pro 
substitutes the character with the appropriate value in the calculation. The following table 
summarizes the currently supported characters: 

Character Name Example Description 
W or X Material Width w/2= Half of the material width 
H or Y Material Height H*2= Twice the height of the material 
T or Z Material Thickness t-0.25= 0.25 units less than the material thickness 
P Pi (3.1415…) P*10^2= Circumference of a 10 radius circle (πr2) 
I Inch Conversion   
M Mm Conversion   
‘ Feet 2’+10= 2 feet & 10 inches (34”) 
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Miscellaneous Improvements in VCarve Pro 
6 

• User Interface Improvements 
o New form layout to more easily identify common areas on toolpath forms etc. 
o User editable files (such as postprocessors & shading materials) moved out of 

program files. 
o 2D and 3D views resize with main window size. 
o Explicit command for importing PhotoVCarve and Cut3D toolpaths. 
o Holding ctrl down with calculate will keep form open 
o ‘Intelligent’ join-close commands to simplify interface 

 In earlier versions of VCarve Pro, closing a single vector required a separate 
set of commands compared to joining multiple vectors. VCarve Pro 6 
intelligently applies the appropriate operation, according to the selection, 
using a single command. If the current selection is just a single, open vector 
then VCarve Pro will apply the ‘close’ version of the selected command. If 
the selection comprises several open vectors, VCarve Pro will apply the ‘join’ 
version of the selected command. 

• Toolpath Improvements 
o An optional border can now be specified on Texturing toolpath form. 
o Toolpath sequencing improvements 

 Machining order for text blocks has been much improved 
 Manual selection of machining order option for profiling, pocketing, drilling, 

carving 
• General Performance Enhancements. 

o VCarve Pro’s data files are now compressed automatically on saving, which can 
provide up to a 50% reduction in file size for complex models. 

o VCarve Pro 6 has had its DWG & DXF file formats updated to improve compatibility 
with newer versions of 3rd party software, such as AutoCAD 2010. 

o 'shortest path' algorithm option added for machining order 
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